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Change Request

	Title:
	Language in MediaObjectSet
	 FORMCHECKBOX 
 Public       FORMCHECKBOX 
 OMA Confidential

	To:
	BAC-BCAST

	Doc to Change:
	OMA-TS-BCAST_ServiceGuide-V1_0_0 (latest version)

	Submission Date:
	17 Aug 2006

	Classification:
	 FORMCHECKBOX 
 0: New Functionality
 FORMCHECKBOX 
 1: Major Change
 FORMCHECKBOX 
 2: Bug Fix
 FORMCHECKBOX 
 3: Clerical

	Source:
	Uwe Rauschenbach, Siemens, uwe.rauschenbac@siemens.com  

	Replaces:
	n/a


1 Reason for Change

This contribution proposes a resolution for review comment SE-183. The use of xml:lang is aligned with the SG TS. Furthermore, some Cardinalities and Types are changed to correctly support multi-language in all the places where such a support was stated in the Descriptions.

Finally, in the eMail template, one attribute (MessageBody) is changed into an element to allow the preservation of whitespace in the message body.
R01 just corrects the title of this document.

	SE-183
	16-5-2006
	N
	5.3.6.1.
	Source: Siemens

From: OMA-BCAST-2006-0482

Comment:
In the table, the description of xml:lang contains editors notes proposing to revise this text. Using the “Language” type provided by XSD to support multiple languages.  In this case, it would be necessary to specify how a MediaObjectSet could support multiple languages.

Proposed resolution:

Harmonize with the description of xml:lang used in SG TS. Consider only one language per mediaObjectSet.


	Status: CLOSED

Closed by CR 719.


2 Impact on Backward Compatibility

None.

3 Impact on Other Specifications

None.

4 Intellectual Property Rights

Members and their Affiliates (collectively, "Members") agree to use their reasonable endeavours to inform timely the Open Mobile Alliance of Essential IPR as they become aware that the Essential IPR is related to the prepared or published Specification.  This obligation does not imply an obligation on Members to conduct IPR searches.  This duty is contained in the Open Mobile Alliance application form to which each Member's attention is drawn.  Members shall submit to the General Manager of Operations of OMA the IPR Statement and the IPR Licensing Declaration.  These forms are available from OMA or online at the OMA website at www.openmobilealliance.org.

5 Recommendation

This CR is presented for agreement and subsequent inclusion in the BCAST Services TS.

6 Detailed Change Proposal

5.3.6.1 Interactivity Media Document

An InteractivityMedia document triggers the Terminal to render the “interactivity media objects” message onto the GUI. The InteractivityMedia document and Media Object Set files is are delivered using BCAST File Distribution functionalitydelivery. The system MAY deliver the InteractivityMedia documents and associated files over broadcast file distribution or serve those over interactive channel. The terminal SHALL support reception of InteractivityMedia documents over broadcast file distribution method. If the terminal supports interactive channel, the terminal SHALL support the retrieval of InteractivityMedia documents and associated files over interaction channel. The delivery method used for the delivery SHALL be signaled within the InteractivityData fragment of the Service Guide as specified in section 5.2.2.10 of [BCAST10-ESG].

The terminal SHALL render the InteractivityMedia objects when the document is completely and successfully retrieved from the file delivery stream and when the interactivity is scheduled to take place. When InteractivityMedia documents with the same GroupID are valid at the same time, the terminal SHALL render those media objects in the document with the highest GroupPosition.

The InteractivityMedia document defines the actual InteractivityMedia objects, which enables e.g. voting or ringtone ordering. The terminal SHALL be able to acquire and render the media objects attached to the InteractivityMedia Document without interrupting the acquisition and rendering of the ‘regular’ broadcast media stream.

Each InteractivityMedia Document can consist of multiple media object groups, and each media group can consist of one or several media object sets. A media object set is a bundle of related media objects to be rendered as a unit (e.g. XHTML pages + external stylesheet + pictures) and clearly identified as pertaining to a specific interactivity technology (SMS, MMS template, XHTML…). From each media object group only one media object set is rendered at the same time by the same terminal. This is indicated by the media object set with the highest relative priority and that is besides supported by the terminal. If a media object set is not supported by the terminal it is discarded and not stored.  If none of the media object sets is supported by the terminal the terminal SHALL display the alternative text.

The media objects of a media object set are packed into one file bundle transported separately from the InteractivityMedia document. The InteractivityMedia document (i.e. the parent Media Object Group) only describes for each media set the involved interactivity technology, the type of included media objects, and the file delivery information needed to retrieve the media objects bundle. This decoupled structure allows the terminal to discard the unsupported media object sets at the very beginning of file bundle reception, and more importantly to avoid their storage.Content promotion can be enabled by one media object group in the InteractivityMedia Document. By referring to this same media object group through the On_Action_Pointer the terminal will always return to the same media object set when the end-user triggered the terminal to send out a message over the interaction channel, as facilitated by e.g. the SMS-template or XHTML MP media object set. Referring to information on an external web-site can be enabled by declaring one media object group with an XHTML MP media object set in the InteractivityMedia document. By omitting the On_Action_Pointer, the XHTML hyperlinks can refer the user to external web-sites.

Time-dependent behaviour of the interaction can be enabled by defining 3 media object groups in the InteractivityMedia document. The first media group defines the media to start with, e.g a list of possible answers of a voting. When the user answers in time (as defined by the Input_Allowed_Time), the user is presented the media object set from the second media group (as defined by the On_Action_Pointer). If the user waits too long or does not provide any input the media object set from the third media group is presented (as defined by the On_Time_Out_Pointer). Setting an Update Flag in the first document to “true” enables the rendering of the media object set for the next question. When the Input_Allowed_time is passed the terminal will start listening to the file delivery channel for the Interactivity_Media_Document with a higher GroupPosition number.  
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	Data Type

	Interactivity Media
	E
	NO/TM
	0..N
	InteractivityMedia.

Contains the following attributes:


GroupID


GroupPosition


id

version

validFrom

validTo

Contains the following sub-elements:


Media_Object_Group



	

	GroupID
	A
	NM/TM
	1
	ID of the group of Interactivity Media document, globally unique
	AnyURI

	GroupPosition
	A
	NM/TM
	1
	Relative position of this document in the group.
	unsignedInt

(32 bits)

	id
	A
	NM/TM
	1
	ID of the InteractivityMedia document, globally unique. 
	AnyURI

	version
	A
	NM/TM
	1
	Version of this fragment. The newer version overrides the older one with the same id as soon as it has been received.
	Byte (8 bits)

	validFrom
	A
	NO/TM
	0..1
	The first moment when the media object sets in this document SHALL be rendered. If not given, the media object sets SHALL be rendered as soon as they are available.
	Integer (32 bits) expressed as NTP time

	validTo
	A
	NO/TM
	0..1
	The last moment when the media object set SHALL be rendered. If not given the rendering is assumed to end in undefined time in the future. 

Whenever there is an InteractivityMedia Document available with the same GroupID but with a higher GroupPosition the terminal SHALL stop rendering the current document. 
	Integer  (32 bits)
expressed as NTP time

	Media_Object_Group
	E1
	NO/TM
	0..N
	Grouping of the media object sets, which serve the same purpose during interactivity, e.g. as a starting media object set, as a media object set to be shown after action was taken or to be shown after time-out was reached.

Has the following attributes:

id

Start_Media_Flag

Has the following sub-elements:

Action_Descriptor


MediaObjectSet (generic structure)

SMSTemplate (non-generic media object set)

EMailTemplate (non-generic media object set)

Alternative text

	

	id
	A
	NM/TM
	1
	The ID of the media group
	AnyURI

	StartMedia_Flag
	A
	NM/TM
	1
	The flag indicates, whether the media object sets in this Media_Object Group should be started with.

There SHALL only be one Media_Object_Group with this flag set to “true” in an Interactivity Media Document
	Boolean

	Action Descriptor
	E2
	NO/TM
	0..1
	The action descriptor describes the behaviour of the terminal when the media objects enable end-user input.

Has the following attributes


Input_allowed_Time

On_Time_Out_Pointer

Update_Flag

On_Action_Pointer


	

	Input_Allowed_Time
	A
	NO/TM
	0..1
	The last moment the terminal allows the end-user to provide end-user input for the active media object set in this media object group.
	Integer  (32 bits)
expressed as NTP time

	On_Time_Out_Pointer
	A
	NO/TM
	0..1
	This pointer refers to the ID of a media object group in this interactivity media document. When the Input_Allowed_Time is passed the terminal SHALL present the appropriate media object set of the media object group indicated by this pointer.

The terminal SHALL NOT present this media object set if the terminal has already presented the media object set indicated by the On_Action_Pointer.
	AnyURI

	Update_Flag
	A
	NO/TM
	0..1
	Whenever this flag is “true” the terminal shall listen to and fetch the following interactivity media document and the associated media objects from the file delivery stream when the Input_allowed_time is passed. The following inter-activity media document is identified by the document with the same group ID and a higher GroupPosition number.
	Boolean

	On_Action_Pointer
	A
	NO/TM
	0..1
	This pointer refers to the ID of a media object group in this interactivity media document. When the end-user undertakes action before the Input_Allowed_Time, which triggers the terminal to send out a message over the interaction channel (e.g. MMS, SMS or HTTP request), the terminal SHALL present the appropriate media object set of the media object group indicated by this pointer. 

If this pointer refers to the same ID as the current media object group, the terminal SHALL return to the same media object set after completing the action. In this case Input_allowed_Time and On_Time_Out_Pointer SHALL NOT be declared.
	AnyURI

	MediaObjectSet
	E2
	NO/TM
	0..N
	A media object set is defines the media objects attached to one interactivity technology proposed in the MediaObjectGroup. These media objects are related to each other, and form an interactivity unit to be rendered upon Media_Object_Group activation (provided this interactivity technology is the one selected for rendering).

The set of media objects is not stored in the Media_Object_Group itself (i.e. in the InteractivityMedia document) but as another external file, where this external file is :

· either one uncompressed media file (like a .3GP video, a .JPEG picture).

· or one GZIP archive file containing one or several compressed media objects (a .GZ file e.g. containing a compressed SMIL + 3GP video + text)

The GZIP archive format is the one defined in [RFC1951] and [RFC1952]. In case the archive contains multiple media objects, it consists of the plain concatenation of each compressed media object (i.e. each GZIP member), as specified in section 2.2 of [RFC1952].

The optional FNAME field SHOULD be set by the sender in each GZIP member header, with an FNAME value in accordance with the <Object> Content-Location one (see below Content-Location description). 

The <MediaObjectSet> element contains the following attributes:


RelativePreference


Content-Type


Content-URI

The language of a MediaObjectSet element is expressed by using the built-in XML attribute xml:lang with this element.
The <MediaObjectSet> element contains the following elements:


Description


File


Object
	

	RelativePreference
	A
	NM/TM
	1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the Media_Object_Group, the BCAST application SHALL render the media object set with the highest relative preference among the media object sets it supports.
	unsignedInt

(32 bits)

	Content-Type
	A
	NM/TM
	1
	Gives the media type of the <MediaObjectSet>’s external file :

· If this media type is ‘application/x-gzip’, the external file is a GZIP archive file containing one or several media objects.

· Otherwise (in this version of the specification) the external file is one uncompressed media file (e.g. ‘video/3gpp’ for a 3GP video file containing a SMIL presentation).

In case the external file is transported by FLUTE, this attribute MUST match the <File> Content-Type value provided in the FDT instance(s) describing this file.
	String

	Content-URI
	A
	NM/TM
	1
	Uniquely identifies the <MediaObjectSet>’s external file within the file delivery session.

In case this external file is transported by FLUTE, this attribute MUST match the <File> Content-Location value provided by the FDT instance(s) describing this file.
	AnyURI

	
	
	
	
	

	


	Description
	E3
	NO/TM
	0..N
	Description of the Media Object Set, possibly in multiple languages. This can be used to provide the end-user extra information regarding the Media Object Set content.

The language is expressed using the built-in XML attribute xml:lang with this element. 
	String

	Object
	E3
	NO/TM
	0..N
	Describe each media object contained in the media object set.

Depending on <MediaObjectSet>’s external file nature:

· if a single uncompressed file, this element is not needed unless it can provide supplemental information not given by parent <MediaObjectSet> (such as <PartType>, etc.).

· if a GZIP archive, the sequence order of <Object>s in <MediaObjectSet> MUST be the same as the sequence of members in the GZIP archive (side-by-side relationship between <Object> sequence and GZIP members).

Contains the following attributes:

Content-Location


Content-Type

Start

Contains the following elements:


PartType


	

	Content-Location
	A
	NM/TM
	0..1
	If <MediaObjectSet>’s external file is an uncompressed file: useless.

If <MediaObjectSet>’s external file is a GZIP archive: 

The external file can be found by decompressing the n-th member of the GZIP archive, given n is the position of the <Object> in the <MediaObjectSet>. 

The Content-Location value SHALL be a Relative-Path Reference as defined in [RFC3986] and SHALL represent the sub-folder(s) + the filename of the deflated GZIP member to be used on storage.

This relative storage content location is intended to be directly pointed by common markup language references (typically via src=”” and href””).

If present, the FNAME field of the GZIP member MAY be verified against the filename part of Content-Location, ignoring case differences. In case these two values differ, the terminal MAY choose to discard the Media Object Set.

When storing the deflated media object, the terminal MUST create any indicated sub-folder(s) specified in the Content-Location, and store the media object in the leaf sub-folder, using the file name indicated in the Content-Location.The terminal SHOULD preserve the letter case specified in the Content-Location value when deflating the subfolders and the media file locally. The dot-segment “.” MUST be supported.  
Content-Location value SHALL be unique within the sequence of <Object> elements belonging to the same <MediaObjectSet> in the following respect: A folder (including root folder) SHALL NOT contain two different subfolders or files for which the names only differ by the letter case.

For security reasons, the terminal SHOULD discard the Media Object Set in case a naming conflict is detected.

For security reasons, the terminal SHOULD discard the Media Object Set if one or several dot-segments “..” are present in the Content-Location.
	AnyURI

	Content-Type
	A
	NM/TM
	1
	If <MediaObjectSet>’s external file is an uncompressed file: useless (information already given in <MediaObjectSet>).

If <MediaObjectSet>’s external file is a GZIP archive:
Gives the media type of the GZIP archive member mapped to the <Object>.
	String

	Start
	A
	NM/TM
	1
	If <MediaObjectSet>’s external file is an uncompressed file, or else a GZIP archive containing one media object: useless (implictly “true”).

If <MediaObjectSet>’s external file is a GZIP archive containing multiple media objects :
This attribute must be set to “true” for exactly one <Object> and one only in the <Object> sequence, the “start media object” on which the interactivity client must be launched.  

Default value, and applicable value for the other <Object> elements : false
	Boolean



	PartType
	E4
	NO/TM
	0..N
	Indicates the media types that should be supported also in order to correctly render an <Object> consisting of several sub-media objects.

E.g. a 3GP “Extended-presentation profile” would be one <Object> with one “application/smil” <PartType>  advertising the presence of a SMIL presentation in the file.
	

	File
	E3
	NO/TM
	0..1
	Present in case ALC without FLUTE is used for the delivery of <MediaObjectSet>’s external file.

Structure identical to the <File> child element of <FileDescription> in Content fragment.

Editor’s note : do we need to duplicate this lengthy description ?
	

	SMSTemplate
	E2
	NO/TM
	0..N
	Contains attributes:

RelativePreference

Presentation

SelectChoice

Note: the SMSTemplate is a media object set, although not encoded using the <MediaObjectSet> generic structure.

Note: The SMS Template provides information about the option(s) in an interaction, but does not contain rendering information. If rendering is to be specified by the service provider, the interaction can alternatively be described in an XHTML document with in-lined SMS URIs.
	

	RelativePreference
	A
	NO/TM
	0..1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the Media_Object_Group, the BCAST application SHALL render the media object set with the highest relative preference of the media object sets it supports.
	unsignedInt

(32 bits)

	Presentation
	E3

	NO/TM
	0..N
	Text describing the interaction to the end user, possibly in multiple languages. The language is expressed using the built-in XML attribute xml:lang with this element.

This text can e.g. describe the overall scope of the interaction, valid for all interaction options described below. It might e.g. also contain information about the prize of the SMS interaction.
	String

	SelectChoice
	E3
	NO/TM
	0..N
	Contains attributes:

SMS-URI

ChoiceText

Note: For an interaction with multiple choices (like a voting between several options), the SelectChoice elements describe the different options to the user, and declare the SMS interaction to be executed when the user selects this option. For an interaction with one choice (e.g. an offer to purchase merchandise like a ringtone), there is only one SelectChoice element. Rendering of the choice(s) to the user is out of scope of this specification.
	

	SMS-URI
	A
	NM/TM
	1
	SMS receiver address and payload encoded as “sms:” URI scheme.

Value of this attribute SHALL comply with “sms:” URI scheme [URI-Schemes], with the following exceptions:

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$userid$”, it shall be replaced by the user ID.

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$deviceid$”, it shall be replaced by the device ID.

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$userinput$”, it should be replaced by a string that the user can enter. This may be an empty string.
	AnyURI

	ChoiceText
	E4
	NO/TM
	0..N

	Description of the interaction option, possibly in multiple languages. This is used to provide the end-user information on this interaction choice.
The language is expressed using the built-in XML attribute xml:lang with this element. 
	String

	EmailTemplate
	E2
	NO/TM
	0..N
	Contains attributes:

RelativePreference

Description

To_header

Cc_header

Bcc_header

Subject_header


MessageBody

Note: the EmailTemplate is a media object set, although not encoded using the <MediaObjectSet> generic structure.
	

	RelativePreference
	A
	NM/TM
	1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the Media_Object_Group, the BCAST application SHALL render the media object set with the highest relative preference of the media object sets it supports.
	unsignedInt

(32 bits)

	Description
	E3
	NO/TM
	0..N
	Description of the Email Template, possibly in multiple languages. This can be used to provide the end-user extra information regarding the Email message.

The language is expressed using the built-in XML attribute xml:lang with this element. 
	String

	To_header
	A
	NM/TM
	1
	The e-mail recipient(s) as defined in [RFC 2822]
	String

	Cc_header
	A
	NO/TM
	0..1
	The e-mail cc-recipient(s) as defined in [RFC 2822]
	String

	Bcc_header
	A
	NO/TM
	0..1
	The e-mail bcc-recipient(s) as defined in [RFC 2822]
	String

	Subject_header
	A
	NO/TM
	0..1
	The e-mail subject header as defined in [RFC 2822]
	String

	MessageBody
	E4

	NO/TM
	0..1
	The e-mail message body (text format defined in [RFC 2822]
	String

	AlternativeText
	E2
	NO/TM
	0..N

	Alternative Text to be displayed if none of the other media object sets is supported by the terminal

Possibly in multiple languages. The language is expressed using the built-in XML attribute xml:lang with this element.
	String

	<proprietary elements>
	
	
	
	Any number of proprietary or application-specific elements that are not defined in this specification.
	

	
	
	
	
	
	








�This has been deleted because in the SG spec, we never use xml:lang in a separate line. Instead, the multi-language element has a note in the description saying that an xml_lang attribute may be attached, and then this is done in XML schema design.


�Attributes can not be 0..N. Change to E3.


�Changed to 0..N to support multiple languages. Changed from A to E4 to support 0..N.


�Let’s use an element here. It is not possible to keep whitespace in an attribute.


�Change to N to support multi-language
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